
ポリシーグループ

•スマートトンネルアクセス（1ページ）
•クライアントレス SSL VPNキャプチャツール（15ページ）
•ポータルアクセスルールの設定（15ページ）
•クライアントレス SSL VPNのパフォーマンスの最適化（17ページ）

スマートトンネルアクセス
次の項では、クライアントレス SSL VPNセッションでスマートトンネルアクセスをイネーブ
ルにする方法、それらのアクセスを提供するアプリケーションの指定、および使用上の注意に

ついて説明します。

スマートトンネルアクセスを設定するには、スマートトンネルリストを作成します。このリ

ストには、スマートトンネルアクセスに適した 1つ以上のアプリケーション、およびこのリ
ストに関連付けられたエンドポイントオペレーティングシステムを含めます。各グループポ

リシーまたはローカルユーザポリシーでは 1つのスマートトンネルリストがサポートされて
いるため、ブラウザベースではないアプリケーションをサポート対象とするために、グループ

化してスマートトンネルリストに加える必要があります。リストを作成したら、1つ以上のグ
ループポリシーまたはローカルユーザポリシーにそのリストを割り当てます。

次の項では、スマートトンネルおよびその設定方法について説明します。

•スマートトンネルについて（2ページ）

•スマートトンネルの前提条件（3ページ）

•スマートトンネルのガイドライン（3ページ）

•スマートトンネルの設定（Lotusの例）（5ページ）

•トンネリングするアプリケーションの設定の簡略化（6ページ）

•スマートトンネルリストについて（11ページ）

•スマートトンネル自動サインオンサーバリストの作成（11ページ）

•スマートトンネル自動サインオンサーバリストへのサーバの追加（12ページ）
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•スマートトンネルアクセスのイネーブル化とオフへの切り替え（13ページ）

•スマートトンネルからのログオフの設定（14ページ）

スマートトンネルについて

スマートトンネルは、TCPベースのアプリケーションとプライベートサイト間の接続です。
このスマートトンネルでは、セキュリティアプライアンスをパスウェイ、ASAをプロキシ
サーバとするクライアントレス（ブラウザベース）SSL VPNセッションが使用されます。ス
マートトンネルアクセスを許可するアプリケーションを特定し、各アプリケーションのロー

カルパスを指定できます。Microsoft Windowsで実行するアプリケーションの場合は、チェッ
クサムの SHA-1ハッシュの一致を、スマートトンネルアクセスを許可する条件として要求も
できます。

Lotus SameTimeおよびMicrosoftOutlookは、スマートトンネルアクセスを許可するアプリケー
ションの例です。

スマートトンネルを設定するには、アプリケーションがクライアントであるか、Web対応ア
プリケーションであるかに応じて、次の手順のいずれかを実行する必要があります。

•クライアントアプリケーションの 1つ以上のスマートトンネルリストを作成し、スマー
トトンネルアクセスを必要とするグループポリシーまたはローカルユーザポリシーにそ

のリストを割り当てます。

•スマートトンネルアクセスに適格なWeb対応アプリケーションの URLを指定する 1つ
以上のブックマークリストエントリを作成し、スマートトンネルアクセスを必要とする

グループポリシーまたはローカルユーザポリシーにそのリストを割り当てます。

また、クライアントレス SSL VPNセッションを介したスマートトンネル接続でのログインク
レデンシャルの送信を自動化するWeb対応アプリケーションのリストも作成できます。

スマートトンネルのメリット

スマートトンネルアクセスでは、クライアントの TCPベースのアプリケーションは、ブラウ
ザベースの VPN接続を使用してサービスにアクセスできます。この方法では、プラグインや
レガシーテクノロジーであるポート転送と比較して、ユーザには次のような利点があります。

•スマートトンネルは、プラグインよりもパフォーマンスが向上します。

•ポート転送とは異なり、スマートトンネルでは、ローカルポートへのローカルアプリケー
ションのユーザ接続を要求しないことにより、ユーザエクスペリエンスが簡略化されま

す。

•ポート転送とは異なり、スマートトンネルでは、ユーザは管理者特権を持つ必要がありま
せん。

プラグインの利点は、クライアントアプリケーションをリモートコンピュータにインストー

ルする必要がないという点です。
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スマートトンネルの前提条件

スマートトンネルでサポートされるプラットフォームとブラウザについては、『サポート対象

の VPNプラットフォーム、Cisco ASA 5500シリーズ』を参照してください。

次の要件と制限事項がWindowsでのスマートトンネルアクセスには適用されます。

• Windowsではブラウザで ActiveXまたは Oracle Javaランタイム環境（JRE 6以降を推奨）
をイネーブルにしておく必要がある。

• Winsock 2のTCPベースのアプリケーションだけ、スマートトンネルアクセスに適する。

• Mac OS Xの場合に限り、Java Web Startをブラウザでイネーブルにしておく必要がある。

•スマートトンネルは、IEの拡張保護モードと互換性がありません。

スマートトンネルのガイドライン

•スマートトンネルは、Microsoft Windowsを実行しているコンピュータとセキュリティア
プライアンス間に配置されたプロキシだけをサポートする。スマートトンネルは、Windows
でシステム全体のパラメータを設定する Internet Explorer設定を使用します。この設定が
プロキシ情報を含む場合があります。

• Windowsコンピュータで、プロキシが ASAにアクセスする必要がある場合は、クラ
イアントのブラウザにスタティックプロキシエントリが必要であり、接続先のホス

トがクライアントのプロキシ例外のリストに含まれている必要があります。

• Windowsコンピュータで、プロキシが ASAにアクセスする必要がなく、プロキシが
ホストアプリケーションにアクセスする必要がある場合は、ASAがクライアントの
プロキシ例外のリストに含まれている必要があります。

プロキシシステムはスタティックプロキシエントリまたは自動設定のクライアントの設

定、または PACファイルによって定義できます。現在、スマートトンネルでは、スタ
ティックプロキシ設定だけがサポートされています。

•スマートトンネルでは、Kerberos Constrained Delegation（KCD）はサポートされない。

• Windowsの場合、コマンドプロンプトから開始したアプリケーションにスマートトンネ
ルアクセスを追加する場合は、スマートトンネルリストの 1つのエントリの [Process
Name]に「cmd.exe」を指定し、別のエントリにアプリケーション自体へのパスを指定す
る必要があります。これは「cmd.exe」がアプリケーションの親であるためです。

• HTTPベースのリモートアクセスによって、いくつかのサブネットが VPNゲートウェイ
へのユーザアクセスをブロックすることがある。これを修正するには、Webとエンドユー
ザの場所との間のトラフィックをルーティングするために ASAの前にプロキシを配置し
ます。このプロキシがCONNECT方式をサポートしている必要があります。認証が必要な
プロキシの場合、スマートトンネルは、基本ダイジェスト認証タイプだけをサポートしま

す。
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•スマートトンネルが開始されると、ASAは、ブラウザプロセスが同じである場合にVPN
セッション経由ですべてのブラウザトラフィックをデフォルトで送信する。また、tunnel-all
ポリシーが適用されている場合にのみ、ASAは同じ処理を行います。ユーザがブラウザ
プロセスの別のインスタンスを開始すると、VPNセッション経由ですべてのトラフィック
が送信されます。ブラウザプロセスが同じで、セキュリティアプライアンスがURLへの
アクセスを提供しない場合、ユーザはそのURLを開くことはできません。回避策として、
tunnel-allではないトンネルポリシーを割り当てます。

•ステートフルフェールオーバーが発生したとき、スマートトンネル接続は保持されませ
ん。ユーザはフェールオーバー後に再接続する必要があります。

•スマートトンネルのMacバージョンは、POSTブックマーク、フォームベースの自動サイ
ンオン、または POSTマクロ置換をサポートしない。

• macOSユーザの場合、ポータルページから起動されたアプリケーションだけがスマート
トンネルセッション接続を確立できる。この要件には、Firefoxに対するスマートトンネ
ルのサポートも含まれます。スマートトンネルを最初に使用する際に、Firefoxを使用し
て Firefoxの別のインスタンスを起動するには、csco_stという名前のユーザプロファイル
が必要です。このユーザプロファイルが存在しない場合、セッションでは、作成するよう

にユーザに要求します。

• macOSでは、SSLライブラリにダイナミックにリンクされた、TCPを使用するアプリケー
ションをスマートトンネルで使用できる。

• macOSでは、スマートトンネルは次をサポートしない。

•サンドボックス化されたアプリケーション（[View] > [Columns]を使用してアクティ
ビティモニタで確認します）。そのため、macOS 10.14および 10.15はスマートトン
ネリングをサポートしていません。

•プロキシサービス

•自動サインオン

• 2つのレベルの名前スペースを使用するアプリケーション

• Telnet、SSH、cURLなどのコンソールベースのアプリケーション

• dlopenまたは dlsymを使用して libsocketコールを見つけ出すアプリケーション

• libsocketコールを見つけ出すスタティックにリンクされたアプリケーション

• macOSでは、プロセスへのフルパスが必要です。また、このパスは大文字と小文字が区
別されます。各ユーザ名のパスを指定しないようにするには、部分パスの前にチルダ（~）
を入力します（例：~/bin/vnc）。

• MacデバイスやWindowsデバイスの Chromeブラウザでスマートトンネルをサポートす
るための新しいメソッドが用意されました。Chrome Smart Tunnel Extensionは、Netscape
プラグインアプリケーションプログラムインターフェイス（NPAPI）に代わるものです。
NPAPIは、Chromeではサポートされなくなりました。
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この拡張プログラムをインストールしていない Chromeでスマートトンネルに対応した
ブックマークをクリックすると、ユーザは拡張プログラムを取得できるようにChromeウェ
ブストアにリダイレクトされます。Chromeを新規インストールする場合、ユーザは拡張
プログラムを取得できるように Chromeウェブストアに移動されます。この拡張プログラ
ムは、スマートトンネルの実行に必要なバイナリを ASAからダウンロードします。

Chromeのデフォルトのダウンロード場所が、現在のユーザの「ダウンロード」フォルダ
を指している必要があります。または、Chromeのダウンロード設定が [Ask every time]で
ある場合は、ユーザは尋ねられたときに「ダウンロード」フォルダを選択する必要があり

ます。

スマートトンネルの使用中、通常のブックマークおよびアプリケーション設定は、新しい

拡張機能のインストールとダウンロード場所指定のプロセス以外は変更されません。

スマートトンネルの設定（Lotusの例）

この例では、アプリケーションでのスマートトンネルサポートを追加するために必要な最小

限の指示だけを示します。詳細については、以降の各項にあるフィールドの説明を参照してく

ださい。

（注）

手順

ステップ 1 [Configuration] > Remote Access VPN > Clientless SSL VPN Access > [Portal] > [Smart Tunnels]
を選択します。

ステップ 2 アプリケーションを追加するスマートトンネルリストをダブルクリックするか、または [Add]
をクリックしてアプリケーションのリストを作成し、[ListName]フィールドにそのリストの名
前を入力して [Add]をクリックします。

たとえば、[Smart Tunnels]ペインで [Add]をクリックし、[List Name]フィールドに Lotusと入
力して [Add]をクリックします。

ステップ 3 [Add or Edit Smart Tunnel List]ダイアログボックスで [Add]をクリックします。

ステップ 4 [Application ID]フィールドに、スマートトンネルリスト内のエントリに対する一意のインデッ
クスとして使用する文字列を入力しします。

ステップ 5 [ProcessName]ダイアログボックスに、ファイル名とアプリケーションの拡張子を入力します。

次の表に、[Application ID]文字列の例と、Lotusをサポートするために必要となる関連付けら
れたパスを示します。

表 1 :スマートトンネルの例：Lotus 6.0 Thick Client with Domino Server 6.5.5

必要最小限のプロセス名アプリケーション IDの例

notes.exelotusnotes
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必要最小限のプロセス名アプリケーション IDの例

nlnotes.exelotusnlnotes

ntaskldr.exelotusntaskldr

nfileret.exelotusnfileret

ステップ 6 [OS]の横の [Windows]を選択します。

ステップ 7 [OK]をクリックします。

ステップ 8 アプリケーションごとにステップを繰り返してリストに追加します。

ステップ 9 [Add or Edit Smart Tunnel List]ダイアログボックスで [OK]をクリックします。

ステップ 10 次のようにして、関連付けられたアプリケーションへのスマートトンネルアクセスを許可す

るグループポリシーとローカルユーザポリシーにリストを割り当てます。

•グループポリシーにリストを割り当てるには、[Configuration] > Remote Access VPN>
Clientless SSL VPN Access > Group Policies > Addまたは [ Edit > Portal]を選択し、[Smart
Tunnel List]ドロップダウンリストからスマートトンネル名を選択します。

•ローカルユーザポリシーにリストを割り当てるには、[Configuration] > Remote Access
VPN> AAA Setup > Local Users > Addまたは [ Edit > VPN Policy > Clientless SSL VPN]を
選択し、[SmartTunnelList]ドロップダウンリストからスマートトンネル名を選択します。

トンネリングするアプリケーションの設定の簡略化

スマートトンネルアプリケーションリストは、基本的に、トンネルへのアクセスを許可する

アプリケーションのフィルタです。デフォルトでは、ブラウザによって開始されるすべてのプ

ロセスに対してアクセスが許可されます。スマートトンネル対応ブックマークによって、クラ

イアントレスセッションではWebブラウザによって開始されるプロセスのみにアクセスが許
可されます。ブラウザ以外のアプリケーションでは、管理者はすべてのアプリケーションをト

ンネリングすることを選択して、エンドユーザがどのアプリケーションを起動するかを知る必

要性をなくすことができます。

この設定は、Windowsプラットフォームのみに適用されます。（注）

次の表に、アクセスを許可されるプロセスの状況を示します。

スマートトンネルアプリケーション

アクセス

スマートトンネル対応ブックマーク状況

アプリケーションリストのプロセス名

と一致するプロセスのみにアクセス権

が付与されます。

アプリケーションリストのプロセス名

と一致する任意のプロセスにアクセス

権が付与されます。

アプリケーションリストが指定される
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スマートトンネルアプリケーション

アクセス

スマートトンネル対応ブックマーク状況

プロセスにアクセス権は付与されませ

ん。

すべてのプロセス（およびその子プロ

セス）にアクセス権が付与されます。

スマートトンネルをオフに切り替える

ブラウザを開始したユーザが所有する

すべてのプロセスにアクセス権が付与

されますが、その子プロセスには付与

されません。

すべてのプロセス（およびその子プロ

セス）にアクセス権が付与されます。

スマートトンネル以外の

Webページによって開始さ
れたプロセスも含まれます

（Webページが同じブラウ
ザプロセスによって処理さ

れる場合）。

（注）

[Smart Tunnel all Applications]チェック
ボックスをオンにする

手順

ステップ 1 [Configuration] > [Remote Access VPN] > [AAA/Local Users] > [Local Users]を選択します。

ステップ 2 [User Account]ウィンドウで、編集するユーザ名を強調表示します。

ステップ 3 [Edit]をクリックします。[Edit User Account]ウィンドウが表示されます。

ステップ 4 [Edit User Account]ウィンドウの左側のサイドバーで、[VPN Policy] > [Clientless SSL VPN]を
クリックします。

ステップ 5 次のいずれかの操作を行います。

• [smart tunnel_all_applications]チェックボックスをオンにします。リストを作成しなくても、
または外部アプリケーションについてエンドユーザが起動する可能性がある実行ファイル

を知らなくても、すべてのアプリケーションがトンネリングされます。

•または、次のトンネルポリシーオプションから選択します。

• [Smart Tunnel Policy]パラメータの [Inherit]チェックボックスをオフにします。

•ネットワークリストから選択し、トンネルオプションの 1つを指定します。指定さ
れたネットワークに対してスマートトンネルを使用する、指定されたネットワークに

対してスマートトンネルを使用しない、またはすべてのネットワークトラフィック

に対してトンネルを使用する、のいずれかです。

スマートトンネルアクセスに適格なアプリケーションの追加

各 ASAのクライアントレス SSL VPNコンフィギュレーションは、スマートトンネルリスト
をサポートしています。各リストは、スマートトンネルアクセスに適格な 1つ以上のアプリ
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ケーションを示します。各グループポリシーまたはユーザ名は 1つのスマートトンネルリス
トのみをサポートするため、サポートされる各アプリケーションのセットをスマートトンネル

リストにグループ化する必要があります。

[Add or Edit Smart Tunnel Entry]ダイアログボックスでは、スマートトンネルリストにあるア
プリケーションの属性を指定できます。

手順

ステップ 1 [Configuration] > [Remote Access VPN] > [Clientless SSL VPN Access] > [Portal] > [Smart Tunnels]
の順に移動し、編集するスマートトンネルアプリケーションリストを選択するか、新しいリ

ストを追加します。

ステップ 2 新しいリストの場合は、アプリケーションまたはプログラムのリストに付ける一意の名前を入
力します。スペースは使用しないでください。

スマートトンネルリストのコンフィギュレーションに続いて、クライアントレス SSL VPNの
グループポリシーとローカルユーザポリシーの [Smart Tunnel List]属性の横にリスト名が表示
されます。他に設定する可能性があるリストと、内容および目的を区別できるような名前を付

けてください。

ステップ 3 [Add]をクリックして、このスマートトンネルリストに必要な数のアプリケーションを追加し
ます。以下に、JSON配列に格納されるパラメータについて説明します。

• [Application ID]：スマートトンネルリストのエントリに命名する文字列を入力します。こ
のユーザ指定の名前は保存され、GUIに戻されます。文字列はオペレーティングシステ
ムに対して一意です。通常は、スマートトンネルアクセスを許可されるアプリケーショ

ンに付けられる名前です。異なるパスまたはハッシュ値を指定するアプリケーションの複

数バージョンをサポートするには、この属性を使用してエントリを差別化し、オペレー

ティングシステム、および各リストエントリによってサポートされているアプリケーショ

ンの名前とバージョンの両方を指定します。文字列は最大 64文字まで使用できます。

• [Process Name]：アプリケーションのファイル名またはパスを入力します。ストリングに
は最大 128文字を使用できます。

Windowsでは、アプリケーションにスマートトンネルアクセスを許可する場合に、この
値とリモートホストのアプリケーションパスの右側の値が完全に一致している必要があ

ります。Windowsでファイル名のみを指定すると、SSL VPNでは、アプリケーションに
スマートトンネルアクセスを許可する場合に、リモートホストに対して場所の制限を強

制しません。

アプリケーションのパスを指定し、ユーザが別の場所にインストールした場合は、そのア

プリケーションは許可されません。アプリケーションは、入力する値と文字列と右側の値

が一致している限り、任意のパスに配置できます。

アプリケーションがリモートホストの複数のパスのいずれかにある場合に、アプリケー

ションにスマートトンネルアクセスを認可するには、このフィールドにアプリケーショ

ンの名前と拡張子だけを指定するか、またはパスごとに固有のスマートトンネルエント

リを作成します。
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スマートトンネルアクセスで突然問題が発生する場合は、[ProcessName]の値が
アップグレードされたアプリケーションに対して最新ではない可能性がありま

す。たとえば、アプリケーションへのデフォルトパスは、そのアプリケーション

および次のアップグレード版を製造する企業が買収されると変更されることがあ

ります。

（注）

Windowsの場合、コマンドプロンプトから開始したアプリケーションにスマートトンネ
ルアクセスを追加する場合は、スマートトンネルリストの 1つのエントリの [Process
Name]に「cmd.exe」を指定し、別のエントリにアプリケーション自体へのパスを指定す
る必要があります。これは「cmd.exe」がアプリケーションの親であるためです。

• [OS]：[Windows]または [Mac]をクリックし、アプリケーションのホストオペレーティン
グシステムを指定します。

• [Hash]（任意、Windowsにのみ該当）：この値を取得するには、アプリケーションのチェッ
クサム（つまり、実行ファイルのチェックサム）を、SHA-1アルゴリズムを使用してハッ
シュを計算するユーティリティに入力します。このようなユーティリティの例として、

Microsoftファイルチェックサム整合性検証（FCIV）を挙げることができます。このユー
ティリティは、http://support.microsoft.com/kb/841290/で入手できます。FCIVのインストー
ル後、スペースを含まないパス（c:/fciv.exeなど）上に、ハッシュするアプリケーション
の一時コピーを置き、コマンドラインで fciv.exe -sha1 applicationと入力して（例：fciv.exe
-sha1 c:\msimn.exe）、SHA-1ハッシュを表示します。

SHA-1ハッシュは、常に 16進数 40文字です。

クライアントレス SSL VPNは、アプリケーションにスマートトンネルアクセスの認可を
与える前に、[Application ID]に一致するアプリケーションのハッシュを計算します。結果
が [Hash]の値と一致すると、アプリケーションのスマートトンネルアクセスが認定され
ます。

ハッシュを入力することにより、[Application ID]で指定した文字列に一致する不正ファイ
ルに対してSSLVPNが資格を与えないようにしています。チェックサムはアプリケーショ
ンのバージョンやパッチに応じて異なるため、[Hash]の入力値が、リモートホストの1つ
のバージョンやパッチにしか一致しないことがあります。アプリケーションの複数のバー

ジョンのハッシュを指定する場合は、それぞれの [Hash]の値に一意のスマートトンネル
エントリを作成します。

[Hash]に値を入力して、スマートトンネルアクセスで今後のアプリケーション
のバージョンやパッチをサポートする必要がある場合は、スマートトンネルリ

ストを更新し続ける必要があります。スマートトンネルアクセスで突然問題が

発生する場合は、[Hash]の値を含んでいるアプリケーションリストが、アプリ
ケーションのアップグレードに対して最新ではない可能性があります。ハッシュ

を入力しないことで、この問題を回避できます。

（注）

ステップ 4 [OK]をクリックしてアプリケーションを保存し、このスマートトンネルリストに必要な数だ
けアプリケーションを作成します。
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ステップ 5 スマートトンネルリストの作成が終わったら、そのリストをアクティブにするには、次の手
順に従って、グループポリシーまたはローカルユーザポリシーにそのリストを割り当てる必

要があります。

•グループポリシーにリストを割り当てるには、Config > Remote Access VPN> Clientless
SSL VPN Access > Group Policies > Add または Edit > Portalを選択し、[Smart Tunnel List]
属性の横にあるドロップダウンリストからスマートトンネル名を選択します。

•ローカルユーザポリシーにリストを割り当てるには、Config > Remote Access VPN> AAA
Setup > Local Users > Add または Edit > VPN Policy > Clientless SSL VPNを選択し、[Smart
TunnelList]属性の横にあるドロップダウンリストからスマートトンネル名を選択します。

表 2 :スマートトンネルエントリの例

OSプロセス名アプリケーション ID
（一意の文字列であれ

ばどれでも OK）

スマートトンネルのサ

ポート

Windowsfirefox.exefirefoxMozilla Firefox

Windowsmsimn.exeoutlook-expressMicrosoft Outlook
Express

Windows\Program Files\Outlook
Express\msimn.exe

outlook-expressより制限的なオプショ

ン：実行ファイルが事

前定義済みのパスにあ

る場合は、Microsoft
Outlook Express専用。

MacTerminalterminalMacで新しいターミナ
ルウィンドウを開く

（ワンタイムパスワー

ドが実装されているの

で、それ以降、同じ

ターミナルウィンドウ

でのアプリケーション

の起動は失敗しま

す）。

MacTerminal open -a
MacTelnet

new-terminal新しいウィンドウでス

マートトンネルを開始

MacTerminal curl
www.example.com

curlMacターミナルウィン
ドウでアプリケーショ

ンを起動
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スマートトンネルリストについて

グループポリシーとユーザ名ごとに、次のいずれかを行うようにクライアントレス SSL VPN
を設定できます。

•ユーザのログイン時に自動的にスマートトンネルアクセスを開始する。

•ユーザのログイン時にスマートトンネルアクセスをイネーブルにする。ただし、ユーザ
はクライアントレスSSLVPNポータルページの [Application Access] > [Start Smart Tunnels]
ボタンを使用して、スマートトンネルアクセスを手動で開始する必要がある。

スマートトンネルログオンオプションは、各グループポリシー

とユーザ名に対して互いに排他的です。1つだけ使用してくださ
い。

（注）

スマートトンネル自動サインオンサーバリストの作成

[Add Smart Tunnel Auto Sign-on Server List]ダイアログボックスで、スマートトンネルのセット
アップ中にログインクレデンシャルの送信を自動化するサーバのリストを追加または編集でき

ます。スマートトンネルの自動サインオンは、Internet Explorerおよび Firefoxで利用可能で
す。

手順

ステップ 1 [Configuration] > [Remote Access VPN] > [Clientless SSL VPN Access] > [Portal] > [Smart Tunnels]
の順に移動し、[Smart Tunnel Auto Sign-on Server List]が展開されていることを確認します。

ステップ 2 [Add]をクリックして、リモートサーバのリストの一意の名前を入力します。設定する可能性
がある他のリストと内容や目的を区別できるような名前を指定してください。文字列は最大64
文字まで使用できます。スペースは使用しないでください。

次のタスク

スマートトンネルの自動サインオンリストを作成した後は、クライアントレス SSL VPNグ
ループポリシーおよびローカルポリシーコンフィギュレーションの下の [Auto Sign-on Server
List]属性の横に、リスト名が表示されます。

（注）
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スマートトンネル自動サインオンサーバリストへのサーバの追加

次の手順では、スマートトンネル接続での自動サインオンを提供するサーバのリストにサーバ

を追加し、そのリストをグループポリシーまたはローカルユーザに割り当てる方法について

説明します。

手順

ステップ 1 [Configuration] > [Remote Access VPN] > [Clientless SSL VPN Access] > [Portal] > [Smart Tunnels]
に移動し、いずれかのリストを選択して、[Edit]をクリックします。

ステップ 2 [Add Smart Tunnel Auto Sign-On Server List]ダイアログで [Add]ボタンをクリックし、スマート
トンネルサーバをもう 1つ追加します。

ステップ 3 自動認証を行うサーバのホスト名または IPアドレスを入力します。

• [Hostname]を選択する場合、自動認証を行うホスト名またはワイルドカードマスクを入力
します。次のワイルドカード文字を使用できます。

• *：任意の数の文字を一致させる、またはどの文字も一致させません。

• ?：単一の文字を一致させます。

• [ ]：かっこ内に指定された範囲内の、任意の 1文字を一致させる。

•たとえば、*.example.comと入力します。このオプションを使用すると、IPアドレス
のダイナミックな変更からコンフィギュレーションを保護します。

• [IP Address]を選択する場合、IPアドレスを入力します。

Firefoxでは、ワイルドカードを使用したホストマスク、IPアドレスを使用した
サブネット、またはネットマスクをサポートしていません。正確なホスト名また

は IPアドレスを使用する必要があります。たとえば、Firefoxでは、*.cisco.com
を入力した場合、email.cisco.comをホストする自動サインオンは失敗します。

（注）

ステップ 4 [WindowsDomain]（オプション）：認証で必要な場合、クリックしてWindowsドメインをユー
ザ名に追加します。このオプションを使用する場合は、1つ以上のグループポリシーまたは
ローカルユーザポリシーにスマートトンネルリストを割り当てる際に、ドメイン名を指定す

る必要があります。

ステップ 5 [HTTP-based Auto Sign-On]（オプション）

• [Authentication Realm]：レルムはWebサイトの保護領域に関連付けられ、認証時に認証プ
ロンプトまたはHTTPヘッダーのいずれかでブラウザに再度渡されます。ここで自動サイ
ンオンが設定され、レルムの文字列が指定されたら、ユーザはレルムの文字列をWebア
プリケーション（Outlook Web Accessなど）で設定し、Webアプリケーションにサインオ
ンすることなくアクセスできます。

イントラネットのWebページのソースコードで使用されるアドレス形式を使用します。
ブラウザアクセス用にスマートトンネル自動サインオンを設定しており、一部のWeb
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ページでホスト名が使用され、他のWebページで IPアドレスが使用されている場合、あ
るいはどちらが使用されているかわからない場合は、両方を異なるスマートトンネル自動

サインオンエントリで指定します。それ以外の場合、Webページのリンクで、指定され
たフォーマットとは異なるフォーマットが使用されると、ユーザがリンクをクリックして

も開きません。

対応するレルムがわからない場合、管理者はログインを一度実行し、プロンプト

ダイアログから文字列を取得する必要があります。

（注）

• [PortNumber]：対応するホストのポート番号を指定します。Firefoxでは、ポート番号が指
定されていない場合、自動サインオンはデフォルトのポート番号 80および 443でそれぞ
れアクセスされた HTTPおよび HTTPSに対して実行されます。

ステップ 6 [OK]をクリックします。

ステップ 7 スマートトンネル自動サインオンサーバリストのコンフィギュレーションに続いて、そのリ
ストをアクティブにするには、グループポリシーまたはローカルユーザポリシーにそのリス

トを割り当てる必要があります。

•グループポリシーにリストを割り当てるには、次の手順を実行します。

1. [Configuration] > [Remote Access VPN] > [Clientless SSL VPN Access] > [Group Policies]の
順に進み、グループポリシーを開きます。

2. [Portal]タブを選択し、[Smart Tunnel]領域を見つけ、[Auto Sign-on Server List]属性の
横にあるドロップダウンリストから自動サインオンサーバリストを選択します。

•ローカルユーザポリシーにリストを割り当てるには、次の手順を実行します。

1. Configuration > Remote Access VPN > AAA/Local Users > Local Usersを選択し、自動
サインオンサーバリストを割り当てるローカルユーザを編集します。

2. [VPNPolicy] > [Clientless SSLVPN]の順に進み、[Smart Tunnel]領域の下の [Auto Sign-on
Server]設定を探します。

3. [Inherit]をオフにして、[Auto Sign-on Server List]属性の横にあるドロップダウンリス
トからサーバリストを選択します。

スマートトンネルアクセスのイネーブル化とオフへの切り替え

デフォルトでは、スマートトンネルはオフになっています。

スマートトンネルアクセスをイネーブルにした場合、ユーザは、クライアントレス SSL VPN
ポータルページの [Application Access] > [Start Smart Tunnels]ボタンを使用して、スマートト
ンネルアクセスを手動で開始する必要があります。
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スマートトンネルからのログオフの設定

ここでは、スマートトンネルからの適切なログオフ方法について説明します。すべてのブラウ

ザウィンドウを閉じるか、通知アイコンを右クリックしてログアウトを確認すると、スマート

トンネルからログオフできます。

ポータルにあるログアウトボタンを使用することを強くお勧めします。この方法は、クライア

ントレス SSL VPN用であり、スマートトンネルが使用されているかどうかに関係なくログオ
フが行われます。通知アイコンは、ブラウザを使用しないスタンドアロンアプリケーションを

使用する場合に限り使用する必要があります。

（注）

親プロセスが終了した場合のスマートトンネルからのログオフの設定

この方法では、ログオフを示すためにすべてのブラウザを閉じることが必要です。スマートト

ンネルのライフタイムは現在、プロセスのライフタイムの開始に結び付けられています。たと

えば、Internet Explorerからスマートトンネルと開始した場合、iexplore.exeが実行されていな
いとスマートトンネルがオフになります。スマートトンネルは、ユーザがログアウトせずに

すべてのブラウザを閉じた場合でも、VPNセッションが終了したと判断します。

場合によっては、ブラウザプロセスがエラーの結果として、意図的にではなく残っていること

があります。また、Secure Desktopを使用しているときに、ユーザが Secure Desktop内ですべ
てのブラウザを閉じてもブラウザプロセスが別のデスクトップで実行されている場合がありま

す。したがって、スマートトンネルは、現在のデスクトップで表示されているウィンドウがな

い場合にすべてのブラウザインスタンスが終了したと見なします。

（注）

通知アイコンを使用したスマートトンネルからのログオフの設定

ブラウザを閉じてもセッションが失われないようにするために、ペアレントプロセスの終了時

にログオフをオフに切り替えることもできます。この方法では、システムトレイの通知アイコ

ンを使用してログアウトします。アイコンは、ユーザがアイコンをクリックしてログアウトす

るまで維持されます。ユーザがログアウトする前にセッションの期限が切れた場合、アイコン

は、次回に接続を試行するまで維持されます。セッションステータスがシステムトレイで更

新されるまで時間がかかることがあります。

このアイコンが、SSLVPNからログアウトする別の方法です。これは、VPNセッションステー
タスのインジケータではありません。

（注）

ポリシーグループ

14

ポリシーグループ

スマートトンネルからのログオフの設定



手順

ステップ 1 [Configuration] > [Remote Access VPN] > [Clientless SSL VPN Access] > [Portal] > [Smart Tunnels]
を選択します。

ステップ 2 [Click on smart-tunnel logoff > icon in the system tray]オプションボタンをイネーブルにしま
す。

ステップ 3 ウィンドウの [Smart Tunnel Networks]部分で、[Add]をオンにして、アイコンを含めるネット
ワークの IPアドレスとホスト名の両方を入力します。

アイコンを右クリックすると、SSLVPNからのログアウトをユーザに求める単一のメ
ニュー項目が表示されます。

（注）

クライアントレス SSL VPNキャプチャツール
クライアントレス SSL VPN CLIには、WebVPN接続では正しく表示されないWebサイトに関
する情報を記録できるキャプチャツールが含まれています。このツールが記録するデータは、

シスコカスタマーサポートの担当者が問題のトラブルシューティングを行う際に役立ちます。

クライアントレス SSL VPNキャプチャツールの出力には次の 2つのファイルが含まれます。

• Webページのアクティビティに応じてmangled.1,2,3,4...など。mangleファイルは、クライ
アントレス SSL VPN接続のページを転送する VPNコンセントレータの htmlのアクショ
ンを記録します。

• Webページのアクティビティに応じて original.1,2,3,4...など。元のファイルは、URLが
VPNコンセントレータに送信したファイルです。

キャプチャツールによってファイル出力を開き、表示するには、[Administration] > [File
Management]に移動します。出力ファイルを圧縮し、シスコサポート担当者に送信します。

クライアントレスSSLVPNキャプチャツールを使用すると、VPNコンセントレータのパフォー
マンスが影響を受けます。出力ファイルを生成した後に、キャプチャツールを必ずオフに切り

替えます。

（注）

ポータルアクセスルールの設定
この拡張機能により、カスタマーは、HTTPヘッダー内に存在するデータに基づいて、クライ
アントレスSSLVPNセッションを許可または拒否するグローバルなクライアントレスSSLVPN
アクセスポリシーを設定できます。ASAはクライアントレス SSL VPNセッションを拒否する
場合、ただちにエンドポイントにエラーコードを返します。
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ASAは、このアクセスポリシーを、エンドポイントが ASAに対して認証する前に評価しま
す。その結果、拒否の場合は、エンドポイントからの追加の接続試行によるASAの処理リソー
スの消費はより少なくなります。

手順

ステップ 1 ASDMを起動し、[Configuration]> [Remote Access VPN]> [Clientless SSL VPN Access]> [Portal]>
[Portal Access Rule]を選択します。

[Portal Access Rule]ウィンドウが開きます。

ステップ 2 [Add]をクリックしてポータルアクセスルールを作成するか、既存のルールを選択して [Edit]>
.をクリックします。

[Add Portal Access Rule]または [Edit Portal Access Rule]ダイアログボックスが開きます。

ステップ 3 1～ 65535のルール番号を [Rule Priority]フィールドに入力します。

ルールは 1～ 65535のプライオリティの順序で処理されます。

ステップ 4 [User Agent]フィールドに、HTTPヘッダーで検索するユーザエージェントの名前を入力しま
す。

•文字列を広範囲に指定するには、文字列をワイルドカード（*）で囲みます。たとえば、
*Thunderbird*です。検索文字列でワイルドカードを使用することを推奨します。ワイルド
カードを使用しないと、ルールがどの文字列とも一致しないか、予期したよりも大幅に少

ない文字列としか一致しない場合があります。

•文字列にスペースが含まれている場合、ASDMによって、ルールの保存時に文字列の最初
と最後に自動的に引用符が追加されます。たとえば、my agentと入力した場合、ASDMに
よってこの文字列は "my agent"として保存されます。ASAでは my agentの一致が検索さ

れます。

スペースを含む文字列に引用符を追加しないでください。ただし、文字列に追加した引用

符を ASAで照合させる場合を除きます。たとえば、“my agent”と入力すると、ASDMは
その文字列を "\"my agent\’"として保存するため、”my agent”を検出しようとしますが、

my agentは見つかりません。

•スペースを含む文字列でワイルドカードを使用する場合は、文字列全体をワイルドカード
で開始して終了します。たとえば、*my agent*です。ASDMによって、ルールの保存時
に、その文字列は自動的に引用符で囲まれます。

ステップ 5 [Action]フィールドで、[Deny]または [Permit]を選択します。

ASAは、この設定に基づいて、クライアントレス SSL VPN接続を拒否または許可します。

ステップ 6 HTTPメッセージコードを [Returned HTTP Code]フィールドに入力します。

HTTPメッセージ番号 403がフィールドにあらかじめ入力されており、これがポータルアクセ
スルールのデフォルト値です。メッセージコードの有効な範囲は 200～ 599です。

ポリシーグループ
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ステップ 7 [OK]をクリックします。

ステップ 8 [Apply]をクリックします。

クライアントレス SSL VPNのパフォーマンスの最適化
ASAには、クライアントレス SSL VPNのパフォーマンスと機能を最適化する複数の方法があ
ります。パフォーマンスの改善には、Webオブジェクトのキャッシングと圧縮が含まれます。
機能性の調整には、コンテンツ変換およびプロキシバイパスの制限の設定が含まれます。その

他に、APCFでコンテンツ変換を調整することもできます。

コンテンツ変換の設定

デフォルトでは、ASAは、コンテンツ変換およびリライトエンジンを介してすべてのクライ
アントレス SSLVPNトラフィックを処理します。これには、JavaScriptや Javaなどの高度な要
素からプロキシHTTPへのトラフィックも含まれますが、そのようなトラフィックでは、ユー
ザがアプリケーションに SSL VPNデバイス内部からアクセスしているのか、それらのデバイ
スに依存せずにアクセスしているのかに応じて、セマンティックやアクセスコントロールの

ルールが異なる場合があります。

Webリソースによっては、高度に個別の処理が要求される場合があります。次の項では、この
ような処理を提供する機能について説明します。組織や関係するWebコンテンツの要件に応
じてこれらの機能のいずれかを使用する場合があります。

プロキシバイパスの使用

プロキシバイパスを使用するようにASAを設定できます。この設定は、プロキシバイパスが
提供する特別なコンテンツリライト機能を使用した方が、アプリケーションやWebリソース
をより有効活用できる場合に行います。プロキシバイパスはコンテンツの書き換えに代わる手

法であり、元のコンテンツの変更を最小限に抑えます。多くの場合、カスタムWebアプリケー
ションでこれを使用すると有効です。

プロキシバイパスには複数のエントリを設定できます。エントリを設定する順序は重要ではあ

りません。インターフェイスとパスマスク、またはインターフェイスとポートにより、プロキ

シバイパスルールが一意に指定されます。

パスマスクではなくポートを使用してプロキシバイパスを設定する場合、ネットワークコン

フィギュレーションによっては、これらのポートがASAにアクセスできるようにするために、
ファイアウォールコンフィギュレーションの変更が必要になることがあります。この制限を回

避するには、パスマスクを使用します。ただし、パスマスクは変化することがあるため、複

数のパスマスクステートメントを使用して変化する可能性をなくすことが必要になる場合が

あります。

パスは、URLで .comや .org、またはその他のタイプのドメイン名の後に続く全体です。たと
えば、www.example.com/hrbenefitsという URLでは、hrbenefitsがパスになります。同様に、
www.example.com/hrinsuranceという URLでは、hrinsuranceがパスです。すべての hrサイトで
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プロキシバイパスを使用する場合は、*（ワイルドカード）を /hr*のように使用して、コマン
ドを複数回使用しないようにできます。

ASAがコンテンツリライトをほとんどまたはまったく実行しない場合のルールを設定できま
す。

手順

ステップ 1 [Configuration] > [Remote Access VPN] > [Clientless SSL VPNAccess] > [Advanced] > [Proxy Bypass]
の順に進みます。

ステップ 2 プロキシバイパスのインターフェイス名を選択します。

ステップ 3 プロキシバイパス用のポートまたは URIを指定します。

• [Port]：（オプションボタン）プロキシバイパスにポートを使用します。有効なポート番
号は 20000～ 21000です。

• [Port]（フィールド）：ASAがプロキシバイパス用に予約する大きな番号のポートを入力
します。

• [Path Mask]：（オプションボタン）プロキシバイパスに URLを使用します。

• [PathMask]：（フィールド）プロキシバイパス用のURLを入力します。このURLには、
正規表現を使用できます。

ステップ 4 プロキシバイパスのターゲット URLを定義します。

• [URL]：（ドロップダウンリスト）プロトコルとして、httpまたは httpsをクリックしま
す。

• [URL]（テキストフィールド）：プロキシバイパスを適用する URLを入力します。

ステップ 5 リライトするコンテンツを指定します。選択肢は、なし、または XML、リンク、およびクッ
キーの組み合わせです。

• [XML]：XMLコンテンツをリライトする場合に選択します。

• [Hostname]：リンクをリライトする場合に選択します。
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